
   

 
 

 
 

 
 
 

GCB REPORTS 
 

This booklet contains information needed to electronically 

file the following forms with the Gambling Control Board: 

 
 LG100A – Lawful Gambling Receipts and Expenses by Site 
 LG100C – Lawful Purpose Expenditures 
 LG100F – Lawful Gambling Fund Reconciliation  
 LG100   – Monthly Lawful Gambling Activity Summary 

   
 
 

 
Questions?  Contact a Compliance Specialist. 

 
Roseville Office 651-539-1900 
St. Peter Office 507-931-5112 

Fergus Falls Office 218-739-7402/7404 
Hibbing Office 218-262-7301 

 
Website:  www.mn.gov/gcb 
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Introduction 

 

Each month, all licensed gambling organizations must complete an electronic file 
(“GCBREPORTS”) prescribed by the Board that includes: 

 LG100A – Lawful Gambling Receipts and Expenses by Site for each permitted 
premises,  

 LG100C - Lawful Purpose Expenditures, and  

 LG100F - Lawful Gambling Fund Reconciliation. 
 

The electronic file, available on the Gambling Control Board’s website, must be emailed to 
the Board by the 20th of the following month. 
 

An LG100, Lawful Gambling Monthly Activity Summary, form is automatically generated 
based on the data entered on forms LG100A, LG100C, and LG100F.  The LG100 is a 

recommended informational form intended for your organization’s internal use.  It may 
also be used to obtain totals needed to complete the Minnesota Department of Revenue’s 
gambling tax forms. 

 
With prior approval, the Gambling Control Board will also accept emailed “text delimited” 

files that contain all of the information on the “GCB USE” worksheet in columns A through 
AM, rows 1 through 64.  This format is typically used by private-sector providers of lawful 

gambling software programs unique to Minnesota lawful gambling.  Text delimited formats 
must be approved by the Gambling Control Board prior to their use. 
 

Blank non-electronic versions of LG100A, LG100C, LG100F, and LG100 are included at the 
end of this booklet.  These forms are for reference only and may not be used to submit 

your monthly reports to the Gambling Control Board. 
 
 

Order of Completion 

 

1. Schedule B2, Lawful Gambling Report of Bar-coded Games (MN Department of 
Revenue form) 

 If your organization conducts paper pull-tab, tipboard, or paddlewheel games, 

the Schedule B2 must be completed before completing the “Receipts and 
Prizes” section of the LG100A. 

 Schedule B2 and instructions are available in the Minnesota Department of 
Revenue’s Minnesota Lawful Gambling Tax booklet or from the agency’s website 
(www.revenue.state.mn.us/businesses/lawful_gambling). 

 
NOTE: Your organization is required to file a Lawful Gambling Monthly Tax 

Return, form G1, with the Minnesota Department of Revenue.  Completion of 
the G1 can be done anytime after completing the Schedule B-2 (if required).  
Information from the G1 is not needed to complete your GCBREPORTS file. 

 

http://www.revenue.state.mn.us/businesses/lawful_gambling
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2. LG100A, Lawful Gambling Receipts and Expenses by Site (GCB electronic form 
included in the GCBREPORTS file) 

 Complete an LG100A for each permitted premises. 

 

3. LG100C, Lawful Purpose Expenditures (GCB electronic form included in the 
GCBREPORTS file) 
 

4. LG100F, Lawful Gambling Fund Reconciliation (GCB electronic form included in 
the GCBREPORTS file) 

 
5. Optional – LG100, Monthly Lawful Gambling Activity Summary (GCB electronic 

form included in the GCBREPORTS file)  

 Enter year-to-date amounts on lines 35 and 37.   
 

 

Internet and Software Requirements 

 

Internet access - Before you begin, you must have internet access on your computer in 
order to download the “GCBREPORTS” file onto your computer each month.  You will also 
use the internet to email the completed electronic file back to the Gambling Control Board. 

 
It’s strongly recommended that you download the “GCBREPORTS” file each month to ensure 

that you are using the most current version. 
 
Internet browser – If you use Internet Explorer, use version 9 or later if possible.  The 

file may not download properly on earlier versions. 
 

Software – GCBREPORTS uses the Microsoft Excel program.  The file works correctly on 
full versions of Microsoft Excel (there may be some glitches with “starter” versions) dated 
2010 or later.  If you do not have Microsoft Excel, free spreadsheet software is available 

online from OpenOffice at www.openoffice.org or from other free online software websites. 
 

If you don’t have Microsoft Excel but have other spreadsheet software, you may be asked 
to choose which program you want to use to open the GCBREPORTS file.  Select the most 
advanced spreadsheet program you have available.  If you have trouble opening the file, 

it may be necessary to upgrade your spreadsheet program. 
 

 

Opening and Downloading the “GCBREPORTS” File 

 

The instructions in this booklet are based on the use of Microsoft Excel 2010.  If you are 
using another spreadsheet program, some computer commands may differ slightly. 

 
1. Go to the Gambling Control Board’s website at www.mn.gov/gcb.  Click on the “GCB 

Monthly Reports” link located in the upper right-hand corner.  (The specific location of 
the GCBREPORTS information is subject to change as the website is updated.) 
 

http://www.openoffice.org/
http://www.mn.gov/gcb
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2. On the right side of the screen under “Quick Links” click on the “Download GCBREPORTS 
03 17 2016”.  If the file has been updated, the month and year of the most recent 

update will follow “GCBREPORTS”.  
 

3. A pop-up window should appear on your screen.  The message will ask whether you 
want to open or save the file.   Select “Open”. 

 

4. On the menu tab at the top of your screen select “File” and then select “Save As”. 
 

5. In the “File name” line rename the file as follows: 

 Name the file in the following format: “LLLLL-MM-YYYY” where L is the five-digit 
organization license number, M is the number of the month (i.e. 11 for 

November), and Y is the four-digit year. 
Example:  An organization with the license number 79898 would save the 

report for February 2016 as 79898-02-2016. 
 After the file is emailed to the Gambling Control Board, you can rename the file 

that’s saved on your computer.  For example, some people prefer to save the 

files with the year first and then the month. In this way, the files are listed on 
their computers in chronological order. 

 
6. On the left side of the window, select the location on your computer where you want 

the file saved, such as “Desktop”, or in “My Documents” where you can create a folder 
for GCBREPORTS. 

 

7. Click on “Save”. 
 

 

No Rounding Required 

 

It is recommended that all income and expenditures be reported on the GCBREPORTS forms 
using both dollars and cents.  In the event that reporting errors are made, using both 

dollars and cents will make it easier to find them. 
 
 

 
 

 

Before You Start Entering Data 

 

“Enable Editing” – You may see a statement at the top of your screen stating that the 
file has been downloaded in “Protected View”.  If so, click on the “Enable Editing” button. 

 

 

Open the file that you just created for the month being reported. 
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Your screen should now look something like this: 
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If your screen doesn’t look like the one on the previous page: 
1. Click on “View” tab at top of screen (arrow #1). 

2. In the “Workbook Views” section, select “Page Layout” (arrow #2). 
3. In the “Show” section, uncheck the boxes next to “Ruler”, “Gridlines”, “Formula 

Bar”, and “Headings” (arrow #3). 
4. In the “Zoom” section, select “100% (arrow #4). 

 

 
 

 
If the form is split into two pages: 

1. Under the “Page Layout” tab, select “Margins” from the menu. 
2. Then select “Custom Margins”. 
3. Set your margins as: 

 The top, bottom, left, and right margins should be set at .25. 
 The header and footer should be set at .3. 

 Reset the margins to these sizes, if necessary, and click OK.  
The page should now view correctly. 

 

 
  

3 
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At the bottom of your screen, you’ll see tabs for each LG100A to be completed. 
 

The tabs for up to ten LG100A forms (for use with up to ten lawful gambling sites) are 
colored light blue.  The tab for the form (worksheet) that is currently active (the one 

that’s showing on your screen) will turn white until you click on the tab for a different 
form.  Then the tab will revert to its original color. 
 

 
 

 
 

If you don’t see a tab for “1st LG100A”, the tab may be hidden on your screen.  To correct 
this, click on the      symbol located on the very lower left corner of your screen.  The 
arrows circled in red below are used to move the tabs to the right or left when your screen 

size is too small to display all tabs at once. 
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LG100A, Lawful Gambling Receipts and Expenses by Site 

 

Click on the “1st LG100A” tab. 
 

 
 
 

Information may only be entered in the green-shaded cells. 

 Information in the white cells is automatically copied or calculated based on the 

entries in the green cells. 
 
Informational Lines at Top of LG100A 

Begin by completing the green-shaded cells at the top of the form. 

 The organization information you enter will automatically be entered on all other 

forms. 
 Enter only numbers in the “License #”, “Site permit #”, “Month reported”, and 

“Year reported” cells. 

 Double-check the accuracy of the numbers entered. 
o Inaccurate license numbers, site permit numbers, months, or years will cause 

your organization to not get credit, at least initially, for having submitted your 
GCBREPORTS file. 

 
Off-Site Activity 
If you had off-site activity, complete a separate LG100A for that site.  In the “Site name” 

cell enter “Off-site activity” and in the “Site permit #” cell, enter “999”. 
 

If you had off-site activity at more than one site, combine all off-site income and 
expenditures onto a single LG100A with a site permit number of “999”. 
 

No Active Sites 
If your organization is no longer actively conducting gambling at any sites, but you have 

income or expenses to report, enter “No active sites” in the “Site name” cell and “998” in 
the “Site permit #” cell. 
 

Lines 1 through 8 
Enter the gross receipts (column A) and prizes paid (column B) for each form of lawful 

gambling conducted at that particular site.  Column C, Net Receipts, is calculated 
automatically (gross receipts minus prizes paid). 
 

Line 1 – Paper pull-tabs 
Report the total gross receipts and prizes paid from paper pull-tab games as 

reported on the Schedule B-2 (Dept. of Revenue form) for that site. 
 
Line 2 – Electronic pull-tabs 

Report the total gross receipts and prizes paid according to a month-end 
statement made available to your organization through your electronic pull-tab 

game distributor. 

ALWAYS begin by completing the “1st LG100A” form first. 
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Line 3 – Non-linked bingo 
Report the total gross receipts and prizes paid according to form LG911, Monthly 

Bingo Summary Worksheet. 
 

Line 4 – Linked bingo 
Report the total gross receipts and prizes paid according to a month-end 
statement made available to your organization by your linked bingo game 

provider. 
 

Line 5 – Paddlewheel without a table 
Report the total gross receipts and prizes paid from “paddlewheel without a table” 
games as reported on the Schedule B-2 (Dept. of Revenue form) for that site.  

The paddlewheel used to conduct these games is typically about 18 inches in 
diameter divided into 30 equal pie-shaped wedges. 

 
Line 6 – Paddlewheel with a table 

Report the total gross receipts and prizes paid from “paddlewheel with a table” 

games as reported on the Schedule B-2 (Dept. of Revenue form) for that site.  
The large paddlewheel used to conduct these games is used in conjunction with a 

slotted table divided by different colors and numbers.  Players place bets on which 
number or color the wheel will stop. 

 
Line 7 – Raffles 

Report the total gross receipts from each raffle completed during the month at 

that site.  Raffle activity is reported on the LG100A for the site where the raffle 
drawing was conducted.  The raffle gross receipts amounts should be taken from 

all forms LG820, Raffle Inventory and Sales Log.  Report the actual cost to the 
organization of all prizes awarded for the completed raffles. 

 

Line 8 – Tipboards 
Report the total gross receipts and prizes paid from tipboard games as reported 

on the Schedule B-2 (Dept. of Revenue form) for that site. 
 

Line 9 – Interest and other income 

Report interest earned on your gambling savings and checking accounts in the month the 
interest is posted to your account.  Also report other lawful gambling income, such as 

proceeds from advertising sales on bingo programs in the month the income was 
received. 
 

Line 10 – Totals 
This line calculates the site’s total gross receipts, prizes, and net receipts amounts 

reported on lines 1 – 9. 
 
 

 
 

 
 

NOTE:  The LG100, Lawful Gambling Activity Summary, lists lawful gambling 
gross receipts, prizes, and net receipts for each activity in the same order using 

the same line numbers as these totals are reported on the Department of 
Revenue’s G1, Lawful Gambling Monthly Tax Return.  All paddlewheel income is 

included on the same line on both the LG100 and the G1. 
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Lines 11 through 21 
Enter the amount expended related to that site’s gambling activity for each allowable 

expense category.  
 

Allocating expenses: 
Some expenses, such as rent, are site-specific.  However, other expenses, such as the 
gambling manager’s bond and accounting fees, should be allocated among all sites.  

For example, if an organization has two sites with roughly equal receipts, and the 
monthly accounting fee was $500 per month, report $250 on each LG100A, line 15 

(Accounting services), for that month. 
 
There are no specific rules for how to allocate expenses among multiple sites – only 

that the allocated amount must be a reasonable estimate of the percentage of the 
expense related to that site’s gambling activity. 

 
Reimbursements: 
Reimbursements for disallowed expenditures that were reported as an allowable 

expense on lines 11 through 21 in previous months are entered as a negative amount 
on the LG100A in the month the reimbursement was made. 

 
Line 11 – Cost of gambling products paid during the month 

From your invoices for each site, enter the actual amount paid through month end for: 
 paper pull-tab games, 
 tipboard games, 

 bingo paper, 
 paddletickets, and 

 raffle tickets. 
 
Include the amount of state and local sales tax and freight charges listed on the 

invoices. 
 

Distributor credit memos 
If you received a credit from a distributor, include the amount (cost of game plus 
sales tax) as a negative amount on line 11. 

 
To transfer unplayed (paper) games between sites 

 on the LG100A for the site that had the game, enter a negative amount on 
line 11 for the cost of the game, and 

 on the LG100A for the site to which the game was moved, enter a positive 

amount on line 11. 
 

Lines 12 – 17 
For each line, enter the site’s expenditures for each allowable expense category. 
 

Line 18 – Rent paid to lessors for conducting lawful gambling 
Form LG216 is recommended to help accurately determine the rent amount to be 

paid.  For bar operations, use the rent amount before any reduction for cash 
shortages. 
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Line 19 – Electronic pull-tab provider fees 

Include payments to a distributor for providing electronic pull-tabs to your 
organization. 

 
Line 20 – Linked bingo game provider fees 
Include fees paid to a linked bingo provider.  Do not include prize contribution 

amounts on this line. 
 

Line 21 – Other miscellaneous allowable expenses 
Report all allowable expenses paid during the month that were not listed on lines 11 
through 20.  Examples include but are not limited to: 

 purchase of permanent gambling equipment, such as a bingo ball selection 
device, 

 office supplies, 
 costs of storing played pull-tab games, 
 mileage reimbursement for attend a Gambling Control Board-sponsored training 

session, and 
 purchase of a Lawful Gambling Manual. 

 
Line 22 – Cash short 

Enter the total net cash shortage amount for all lawful gambling activity reported on 
lines 1 through 8.  In the rare event that the organization was actually cash long for the 
month, enter the amount as a negative number on line 22. 

 
Cash shortage amounts for each form of lawful gambling are calculated on the following 

forms: 
Paper pull-tabs Schedule B-2 
Electronic pull-tabs LG861e 

Non-linked bingo LG911 
Linked bingo LG861e 

Paddlewheel Schedule B-2 
Raffles LG820 
Tipboards Schedule B-2 

 
Line 23 – Reimbursement for excess cash shortages 

 Bar-op sites:  Enter any reduction in rent for cash shortages on line 23 in the 
month the rent check is written.  Cash shortages for bar operations must be either 
deducted from the rent payment or reimbursed by the lessor by the 20th day of the 

following month. 
 

 Booth-op or owned sites:  Complete the Worksheet CS, Lawful Gambling Cash 
Shortage Reimbursement, each month for each site (form available at 
www.mn.gov/gcb).  Cumulative total cash shortages start over at zero on July 1 

of each year and end on June 30 of the following year.  For each site, if the total 
cash shortages for the year exceed 0.3% of gross receipts, you must reimburse the 

gambling account from nongambling sources by July 20. 
 

http://www.mn.gov/gcb
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NOTE: Enter the reimbursement amount as a positive number on line 23 in the 
month the reimbursement was made.  The number will automatically convert to 

a negative amount. 
 

Line 24 – Total allowable expenses 
This line is calculated automatically based on the amounts reported on lines 11 through 
23. 

 
Line 25 – Starting cash banks per site records 

Starting cash banks are used to make change and to pay prizes awarded before there is 
sufficient income from the game(s) to cover those prizes.  For line 25, add the following to 
the previous month’s line 25 amount: 

 new starting cash banks 
o Example:  In July, your organization had two pull-tab games in play at the 

site with a $500 starting cash bank for each game.  In August, a third pull-
tab game was added with another $500 starting cash bank.  The amount 
reported on line 25 for July would be $1,000 and the amount on line 25 for 

August would be $1,500. 
 increases to existing starting cash banks 

o Example:  In July your organization had two pull-tab games in play at the 
site with a $300 starting cash bank for each game.  In August, the starting 

cash bank for each game was increased to $500.  The amount reported on 
line 25 for July would be $600 and the amount on line 25 for August would 
be $1,000. 

 
Subtract any decreases to the existing starting cash banks not related to negative net 

receipt games. 
 
Example:  In July your organization had two pull-tab games in play at the site, each 

with a $500 starting cash bank.  In August you decided to only have one game in play 
at the site and the $500 starting cash bank for the discontinued game was deposited 

into your gambling account.  The amount reported on line 25 for July would be $1,000 
and the amount on line 25 for August would be $500. 

 

Line 26 – Unreimbursed starting cash banks 
Occasionally a game will close with negative net receipts (the prizes paid out exceeded 

the gross receipts).  In these cases, the starting cash bank amount will be lower after the 
game closed than when the game was initially placed into play. 
 

If at month end the starting bank for one or more games with negative net receipts has 
not yet been reimbursed, enter the total unreimbursed amount on line 26 as a positive 

number. 
 
Line 27 – Total starting cash banks 

This line is calculated based on the amounts entered on lines 25 and 26.  The amount on 
line 27 should equal the actual amount in the site’s cash drawers less the proceeds from 

the games in play that have not yet been taken from the site for deposit. 
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Line 28 – Ending inventory 
 To determine the ending inventory value to report on line 28, you must conduct a 

physical inventory after the close of gambling activity at month end, but prior to the 
start of gambling for the next month. 

 Enter the total value of the physical inventory for this site including the value of 
paper pull-tabs, bingo paper, raffle tickets, paddletickets, and tipboards unplayed 
or in play at month end. 

 Do not include sales tax or freight charges. 
 

Line 29 – Net profit less state taxes on lawful gambling 
This amount is automatically calculated and may be used as the basis for a required 
contribution of up to 10% to a fund administered by a local unit of government. 

 
NOTE:  The amount calculated on line 29 will not be accurate until AFTER the state 

gambling tax and regulatory fee amount(s) paid to the MN Department of Revenue 
have been reported on the LG100C, Lawful Purpose Expenditures form. 
 

How line 29 is automatically calculated 
The net profit less state taxes amount on each LG100A is calculated by: 

1. dividing the site’s net receipts (LG100A, line 10c) by the organization’s total net 
receipts (LG100, line 10c), 

2. multiplying the organization’s state taxes and regulatory fee total as reported 
on the LG100C by the percentage from step 1 above, 
a. Note that any local or federal taxes, if applicable, are not included in the 

calculation for line 29. 
3. adding the site’s total allowable expenses (LG100A, line 24) to the amount from 

step 2 above, and 
4. subtracting the amount from step 3 above from the site’s net receipts (LG100A, 

line 10c). 

 
 

 
 
 

Additional Sites 
If you have more than one site, click on the “2nd LG100A” tab at the bottom of your 

screen and complete an LG100A for that site’s gambling activity.  Follow the same 
procedures for completing the first LG100A.  Repeat this same process for up to ten sites. 
 

If you have more than ten sites, contact your Compliance Specialist.  A special version of 
the LG100 Monthly Lawful Gambling Activity Summary file can be created to 

accommodate your needs. 
 
Inactive Sites 

Do not complete an LG100A for a site that did not have an active premises permit for that 
month.  Expenditures related to an inactive site should be allocated among all active sites.  

If you didn’t have any sites with an active premises permit, enter all activity on one 
LG100A and enter “998” for the site number. 

When finished with your first LG100A, click on “File”, then “Save”. 
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LG100C, Lawful Purpose Expenditures 

 
LG100C is used to report all of your organization’s lawful purpose expenditures. 

 
At the bottom of your screen, you’ll see tabs for each of the forms to be completed.  Click 
on the “LG100C” tab. 

 

 
 
LG100C Formatting Problems 

The LG100C is designed in “landscape” format (11” width and 8.5” height).  If the form 
does not appear on your screen correctly, click on the “Page Layout” tab at the top of your 
screen.  Then click on “Orientation”.  Then click on “Landscape”.  The page should now 

display correctly. 
 

If the form is split into two pages: 
 Under the “Page Layout” tab, select “Margins” from the menu.  (See LG100A 

section for screen display.) 

 Then select “Custom Margins”. 
 Reset the margins to these sizes, if necessary, and click OK. 

o top, bottom, left, and right margins should be set at .25”. 
o header and footer should be set at .3”. 

The page should now view correctly. 

 
Organization information 

All of the organization information at the top of LG100C will already be completed based 
on the information you entered on the “1st LG100A”.  If this information is incorrect, you 
must go back to “1st LG100A” and correct the information on that form. 

 
If No Expenditures 

If your organization did not make any LG100C expenditures during the month, click on 
the triangle next to the green answer box, and select “no”. 
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State Gambling Tax and Regulatory Fee 
The “Payee”, “Description”, and “Lawful Purpose Code” fields are already completed for 

the first three lines of LG100C.   
 

 
 

 
These lines are used exclusively to report the state gambling tax and regulatory fee 
amount actually paid to the Minnesota Department of Revenue during the month being 

reported. 
 

NOTE: On the Minnesota Department of Revenue’s Monthly Lawful Gambling Tax 
Return, form G1, the state gambling tax and regulatory fee amount is computed 
and reported for the month it was incurred.  In other words, the tax is shown on 

the same month’s G1 as the receipts upon which the tax is based.  For example, 
the state gambling tax and regulatory fee amount calculated and reported on the 

Department of Revenue’s G1 tax return for June is actually paid in July.  Because 
the tax wasn’t paid in June, but was paid in July, it is reported on the Gambling 
Control Board’s LG100C for July. 

 
Organizations typically issue one check or make one electronic transfer each month to pay 

the state gambling tax and regulatory fee amount to the Department of Revenue.  This 
payment should be reported on the first line of the LG100C’s “State Gambling Tax and 
Regulatory Fee” section. 

 
Occasionally, an organization may make more than one expenditure per month for state 

gambling tax and regulatory fee.  For example, an organization may have filed an 
amended G1 and owe additional tax.  An organization might also receive a separate 
refund check for taxes that were overpaid.  Any additional payments made or refunds 

received during the month must be reported on the “State Gambling Tax and Regulatory 
Fee” section of the LG100C.  If more than two additional lines are needed, combine all 

remaining expenditures/refunds on the third line of the “State Gambling Tax and 
Regulatory Fee” section. 
 

Penalty and Interest 
If, along with the state gambling tax and regulatory fee, your organization also paid 

penalty and/or interest related to state gambling taxes, these amounts should be 
reported on the LG100A, line 13, and not on the LG100C. 

 
For each expenditure or refund listed in the “State Gambling Tax and Regulatory Fee” 
section, enter: 

1. The membership approval date.  All expenditures require membership approval 
prior to being made. 
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2. The date the check was issued, the electronic payment was made, or the refund 
check or electronic transfer was received. 

3. The check number.  For electronic transfers enter “ET”. 
4. The amount of the expenditure or refund. 

 
All Other Lawful Purpose Expenditures 
All lawful purpose expenditures made during the month, except the state gambling tax 

and regulatory fee, are reported in the “All Other Lawful Purpose Expenditures” section of 
LG100C. 

 
For each expenditure listed, enter: 

1. The membership approval date.  All expenditures require membership approval 

prior to being made. 
2. The date the check was issued or the electronic payment was made. 

3. The check number.  For electronic transfers enter “ET”. 
4. The amount of the expenditure. 
5. The payee as listed on the check, or for electronic transfers, as listed on the bank 

statement. 
6. A description of the purpose of the donation.  Examples include: “repair honor 

guard uniforms”, “purchase bats for little league team”, “food for homeless 
people”, etc. 

7. If applicable, the date the expenditure was specifically approved by the Gambling 
Control Board.  Certain expenditures, such as a donation to another licensed 
organization, require the prior written approval of the Gambling Control Board. 

8. The lawful purpose code. 
 Refer to the list of codes provided in the Lawful Gambling Manual chapter on 

lawful purpose expenditures or online at www.mn.gov/gcb. 
 Enter code “99” for any board-approved expenditures for which a code starting 

with the letter “b” was formerly used. 

9. The amount of the check or electronic transfer. 
 

 

DO NOT LEAVE ANY EMPTY ROWS BETWEEN EXPENDITURES 
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Records 
The organization must keep supporting documentation for each expenditure for at least  

3½ years.  The organization is responsible for providing proof that the expenditure 
qualified as a lawful purpose.  If an expenditure is determined not to qualify as a lawful 

purpose, the organization will be required to reimburse its gambling account for the 
amount of the expenditure with funds from a nongambling source. 
 

Total Lawful Purpose Expenditures 
This amount is located just under the “year reported” cell at the top of the form.  The total 

calculates automatically based on the amounts entered for each individual expenditure. 
 
Complete All Columns 

All columns must be completed for each expenditure except that the GCB approval date is 
only entered when applicable. 

 
More Than 50 Expenditures 
There are enough lines to enter up to 50 expenditures (22 on the first page and 28 on the 

second page).  If you made more than 50 expenditures during the month, contact your 
Compliance Specialist for instructions on how to combine multiple expenditures onto a 

single line. 
 

Termination of License 
Even after the Gambling Control Board approves your organization’s license termination 
plan, you are required to continue filing GCBREPORTS until all gambling funds have been 

spent. 
 

Reimbursements 
A disallowed expenditure that was reported as a lawful purpose expenditure in a previous 
month is entered as a negative amount on the LG100C in the month the reimbursement 

was made. 
 

 
 
 

 
  

When finished with LG100C, click on “File”, then “Save”. 
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LG100F, Lawful Gambling Fund Reconciliation 

 

LG100F is used to determine whether your month-end bank balance reconciles with your 
profit carryover.  The profit carryover figure represents the cumulative total value of the 

organization’s gambling assets less liabilities.  It is calculated based on the amounts 
reported on the organization’s monthly reports filed since the organization was first 
licensed. 

 
An LG100A for each site and the LG100C must be completed prior to completing the 

LG100F. 
 
At the bottom of your screen, you’ll see tabs for each of the forms to be completed.  Click 

on tab “LG100F”. 
 

 
 

Complete each applicable green-shaded cell on the LG100F.  Green-shaded cells that are 
left blank will automatically calculate as “$0”. 
 

Lines 1 through 4 
Line 4 should equal the month-end balance in your gambling account check register.  If 

not, double-check the amounts on lines 1, 2, and 3 and the accuracy of your check 
register balance. 
 

If your organization uses multiple gambling checking accounts, combine the amounts of 
all accounts on lines 1, 2, and 3. 

 
Line 5 
This amount is calculated automatically based on the amounts reported on the LG100A for 

each site.  If the amount on LG100F is incorrect, double check the amounts reported on 
lines 25 and 26 of each LG100A. 

 
Line 6 
Use this line to report cash received from games reported on LG100A that has not yet 

been deposited. 
 

Distinction between LG100F, lines 2 and 6 
 If the deposit was made before the end of the month (the deposit is listed in your 

check register), but the deposit is not listed on that month’s bank statement, report 
the deposit amount on line 2. 

 If the deposit wasn’t made until after the end of the month (the deposit isn’t listed 

in your check register), report the deposit amount on line 6. 
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Line 7 
Report all gambling funds kept in a savings or other non-checking account, such as a 

certificate of deposit (CD).  Note that all gambling funds must be deposited in a bank, 
credit union, or savings and loan.  It is not lawful to invest gambling funds in stocks, 

bonds, treasury bills, etc. 
 
Lines 8 and 9 

If your organization has experienced a fund loss by questionable means (see the Lawful 
Gambling Manual for more information on this topic), your organization is required to 

either file a Fund Loss Request for Profit Carryover Adjustment (form LG250) or to 
reimburse its gambling account from nongambling funds for the amount of the fund loss. 
 

If, at the end of the month, your organization had not yet reimbursed its gambling 
account for the amount of the fund loss, and your organization has: 

 submitted an LG250 form, but the Gambling Control Board has not yet taken action 
on your fund loss request, enter the amount of the pending fund loss request on 
LG100F, line 8. 

 not submitted an LG250 fund loss request to the Gambling Control Board, enter the 
amount of the fund loss on LG100F, line 9. 

 received a letter from the Gambling Control Board denying all or a portion of your 
LG250 fund loss request, entered the denied amount on LG100F, line 9. 

 
Line 10 
Enter the value of month-end merchandise prize inventory based on the actual cost to the 

organization of the merchandise prizes.  If all prizes were donated, enter $0. 
 

Line 11 
This line is used to account for unique circumstances affecting the account balance.  
Contact your Compliance Specialist to ensure the accuracy of any amounts reported on 

this line.  In the space below line 29, explain the “other additions” included on line 11. 
 

Line 12 
The “Total additions” line is included for accounting purposes. 
 

Line 13 
If your organization conducts linked bingo, it’s likely that you will owe additional prize 

money to the linked bingo provider at the end of each month.  This is because the amount 
your organization actually paid for prizes during the month was less than your 
organization’s share of the total prizes awarded.  If so, enter the amount owed as a 

positive number on this line. 
 

Occasionally, your organization will have actually paid out more than its share of the total 
prizes awarded during the month.  If so, the linked bingo provider owes your organization 
and the amount owed should be entered as a negative number on line 13. 

 
The monthly statement provided to each participating organization by the linked bingo 

provider will indicate the amount to be reported on line 13. 
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Line 14 
The most common use of this line is to report cash deposited from raffle sales in a month 

prior to the raffle drawing date.  However, any amounts deposited into the gambling 
account for gambling activity not yet reported on lines 1 through 8 of an LG100A must be 

reported on LG100F, line 14. 
 
Line 15 

Use this line to report original start-up loan amounts or emergency loans that have not 
yet been repaid. 

 
Line 16 
If your organization awarded any merchandise prizes or had any merchandise prizes in its 

possession that had not yet been paid for at the end of the month, enter the amount 
owed on line 16. 

 
Line 17 
This line is used to report raffle and other prizes reported on an LG100A that had not yet 

been paid to the winner(s) at month end.  For example, if your organization’s raffle 
drawing was on April 30, the cash prizes would be reported on April’s LG100A.  However, 

since the prize checks weren’t written to the winners until the next day, May 1, the 
amount of the checks would be reported on the April LG100F, line 17. 

 
Line 18 
This line is used to account for unique circumstances affecting the account balance.  

Contact your Compliance Specialist to ensure the accuracy of any amounts reported on 
this line.  In the space below line 29, explain the “other subtractions” included on line 18. 

 
Line 19 
The “Total subtractions” line is included for accounting purposes. 

 
Lines 20 through 24 

These amounts are calculated based on amounts reported on LG100A, LG100C, and 
previous lines of the LG100F.  They are used to calculate your organization’s profit 
carryover and the profit carryover variance, if any. 

 
Line 25 

Enter the amount from the previous month’s LG100F, line 27. 
 
 

 
 

COMMON ERROR ALERT! – The amount reported on LG100F, line 25, must 
equal the amount reported on LG100F, line 27, in the prior month. 
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Line 26 
Do not include any amount on this line unless you have received written approval from 

the Gambling Control Board.  The written approval may be a compliance review report, 
letter, email, or any other form written authorization.  Keep the approval letter or other 

written documentation with your records.  Adjustments may be a negative amount. 
 
Line 27 

This is your month-end profit carryover figure.  It’s the amount that must be included on 
line 25 of next month’s LG100F. 

 
Line 28 
The amount on line 28 is calculated by subtracting the amount on line 27 (End-of-month 

profit carryover) from the amount on line 20 (Reconciled gambling fund balance). 
 

The amounts on lines 20 and 27 should be the same, and line 28 should be $0.  If the 
amount on line 28 is not zero, either: 

 a reporting error has been made; 

 money has mistakenly been added to the organization’s gambling account or cash 
banks, or merchandise has mistakenly been added to its inventory; or 

 money is missing from the organization’s gambling accounts or cash banks, or 
merchandise is missing from the organization’s inventory. 

 
Profit carryover variance 
If the amount on line 28 isn’t $0, but it equals the previous month’s line 28, it’s likely that 

the errors were made in a prior month.  Correct the prior month’s GCBREPORTS file, and 
then enter the revised profit carryover figure from LG100F, line 27, on the current 

month’s LG100F, line 25.  The amount on the current month’s LG100F, line 28, should 
now be $0. 
 

If the profit carryover variance (LG100F, line 28) differs from the previous month’s profit 
carryover variance, check your reports for errors.  Common errors include: 

 numbers incorrectly transferred from other forms; 
 games played but not reported on Schedule B2; 
 fund losses not reported or reported incorrectly; 

 expenses reported twice, such as reporting a newspaper ad both as an Advertising 
Expense on LG100A, line 14, and a Miscellaneous Expense on LG100A, line 21; 

 raffle, paper bingo, interest, or other gambling income not reported on LG100A; 
 bank charges or other electronic expenditures not reported on LG100A; 
 credits or deposits for returned items not subtracted from expenses on LG100A; 

 deposits in transit and outstanding checks not accounted for on LG100F; and 
 incorrect reporting of merchandise prizes. 

 
Make every effort to find errors before submitting your reports to the Gambling Control 
Board or the Department of Revenue.  The longer errors remain unresolved, the more 

difficult it becomes to find and correct them. 
  

When finished with LG100F, click on “File”, then “Save”. 
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LG100 Monthly Lawful Gambling Activity Summary 

 

The LG100 is an informational form intended for your organization’s internal use.  With 
the exception of lines 35 and 37, all of the information completes automatically based on 

the amounts entered on the LG100A(s), LG100C, and LG100F. 
 
The amounts shown combine the amounts reported for each site into a monthly summary 

for the gambling operation as a whole. 
 

 
 
 

 
 

 
 
Lines 1 through 10 

The LG100, Lawful Gambling Activity Summary, lists lawful gambling gross receipts, 
prizes, and net receipts for each activity in the same order, and using the same line 

numbers, as these totals are reported on the Department of Revenue’s G1, Lawful 
Gambling Monthly Tax Return.  All paddlewheel income is included on the same line on 

both the LG100 and the G1.  This is done so that the sum of the income amounts reported 
on the LG100 can more easily be transferred, when applicable, to the G1. 
 

Line 29 
Your organization’s net profit after state taxes on lawful gambling is computed by: 

 subtracting prizes paid from gross receipts to get net receipts; then 
 subtracting allowable expenses from net receipts to get net profit; then 
 subtracting the state gambling tax and regulatory fee paid to the Dept. of Revenue. 

 
Note that the combined net receipts tax rates increase once an organization’s net receipts 

from pull-tabs, linked bingo, and tipboards total over $87,500 per year (July – June).  As 
a result, the monthly profit shown on line 29 could be considerably larger in July when the 
tax rate is low than in June when the tax rate is higher—even though income and 

allowable expenses were the same in both months. 
 

Line 30 
Statute defines lawful purpose expenditures coded A1 – A7, A10 – A15, and A19 as 
“charitable contributions”.  For more information, refer to the list of codes provided in the 

Lawful Gambling Manual chapter on lawful purpose expenditures or online at 
www.mn.gov/gcb. 

 
Line 31 
“Taxes and fees” includes all expenditures listed on the LG100C that are coded A8 and 

A18 including local, state, and federal taxes on gambling, and licensing fees paid to the 
Gambling Control Board. 

 

MULTIPLE SITES?  DOUBLE CHECK ALLOCATED EXPENSES 

For expenses that were allocated among multiple sites, check the amount 
shown for expenses on the LG100.  The LG100 total should match the 

actual payments as shown in your check register. 
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Line 32 
“Other lawful purpose expenditures” includes expenditures listed on the LG100C that are 

coded A9, A16 – A17, and A20 – A26.  For more information, refer to the list of codes 
provided in the Lawful Gambling Manual chapter on lawful purpose expenditures or online 

at www.mn.gov/gcb. 
 
Lines 35 and 37 

These lines are used to bring the year-to-date (July through June) totals forward to the 
current month.  When completing the LG100 for July, enter $0 on both lines.  For all other 

months, enter the amounts from the previous month’s LG100, lines 36 and 38. 
   
Lines 34 and 39, Lawful Purpose Percentage (Star Rating) 

These lines help your organization monitor compliance with the minimum lawful purpose 
percentage requirement.  Organizations are required to spend at least 30% (20% for 

organizations that only conduct gambling at a site where the primary business is bingo) of 
their net receipts on lawful purpose expenditures each year (July – June). 
 

Line 40 
The profit carryover figure represents the cumulative (starting with the very first monthly 

report filed by the organization) total value of the organization’s gambling assets less 
liabilities. 

 
Line 41 
Any amount on this line other than $0 indicates that your month-end bank balance does 

not reconcile with your profit carryover.  Typically, this is the result of reporting errors 
made on the current or prior months’ GCBREPORTS.  However, it could also indicate that 

money is missing from the gambling account or that money has been mistakenly 
deposited into the gambling account. 
 

 
 

 
 
 

 
 

 
  

“GCB USE” TAB 

Do not attempt to enter any information or make any formatting changes to the 
“GCB USE” worksheet.  It is formatted specifically to allow for the quick 
transfer of your data to the Gambling Control Board’s GCBREPORTS tables. 

When finished with LG100, click on “File”, then “Save”. 
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Printing the Forms 

 

1. Click on the “1st LG100A” tab. 
2. Hold down the “Ctrl” key and click the tabs of the other forms you want to print. 

3. Each of the forms you want printed should be highlighted.  In the example below, the 
1st LG100A, the 2nd LG100A, the 3rd LG100A, and the LG100C, LG100F, and LG100 are 
all highlighted.  

 

 
 

 
4. Click on “File” tab and select “Print”. 
5. Under “Settings” select “Print Active Sheets”. 

 

 
 

 
6. Click on the “Print” icon. 
7. If sheets don’t print out correctly, see the “troubleshooting” section of these 

instructions. 
 

  
DOUBLE CHECK YOUR WORK 

Many GCBREPORTS problems are the result of simple data entry errors.  Sometimes 

these errors are easier to find after you’ve printed the completed forms.  Please 
take the time to review your reports before submitting them. 
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Email Electronic File to Gambling Control Board 

 

1. Open your email program (for example, Yahoo Mail, Gmail, Windows Live, Microsoft 
Outlook, etc.). 

2. Attach the electronic file to your email.  This process differs depending upon which 
email program you use. 

3. In the subject line, enter the license #, month, and year of report in the same format 

as the file name (LLLLL-MM-YYYY), (see page 3, item #5, for more information). 
4. Send the email to:  gcbreports@gcb.state.mn.us 

5. You will receive an automated reply confirming that we received your reports. 
 

 

Amending LG100A, LG100C, and LG100F 

 

If you need to make any changes to the GCBREPORTS file you originally emailed to the 
Gambling Control Board, you may email an amended version. 
 

1. Open the “GCBREPORTS” file you saved on your computer for the month you’d like to 
amend. 

2. Click on the “File” tab and select “Save As”. 
3. Rename the file by simply adding “-amended” to the end of the file name. 

4. Make any necessary changes. 
5. Email the entire file to the Gambling Control Board using the same procedure as when 

filing an original return except that the “Subject” line should reflect the new file name. 

 
LG100 – If the amounts entered on lines 35 or 37 were incorrect, they should be 

corrected for the organization’s own records.  However, it is not necessary to file an 
amended GCBREPORTS solely to correct these errors. 
 

 

TROUBLESHOOTING 

 
AUTO-COMPLETE IN GREEN CELLS 
 

Problem:  If I type one or two letters in a cell, words from other cells are 
automatically entered. 
 

Fix:  Disable “AutoComplete” function. 
 

Instructions: 

1. Click on “File” tab. 
2. Click on “Options” (located in left column below “Help”). 
3. Click on “Advanced”. 

4. Under “Editing Options”, uncheck box next to “Enable AutoComplete for cell 
values”. 

5. Click on “OK” at the bottom left of that screen. 
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X’s IN CELLS 
 

Problem:  If I type in large numbers, they show as x’s on my screen. 
Fix:  Expand view so that numbers fit into cells. 
 

Instructions: 

1. Click on “View” tab. 
2. Click on “100%” icon located just below the “View” tab. 

 

CURSOR MOVES DOWN 
 

Problem:  After I enter something in a cell and hit “enter” on my keyboard, the 
cursor moves to the next cell down instead of to the next cell to the right. 
 

Fix:  Change default setting. 
 

Instructions: 
1. Click on “File” tab. 

2. Click on “Options” (located in left column below “Help”). 
3. Click on “Advanced”. 

4. Under “Editing Options”, check the box next to “After pressing Enter, move 
selection”. 

5. Below that, next to “Direction:”, select “Right” from the drop-down menu. 

6. Click on “OK” at the bottom left of that screen. 
 

CAN’T READ FORMS ON SCREEN 
 

Problem:  It’s difficult to see and read the forms on my computer screen. 
 

Fix:  Adjust view settings. 
 

Instructions: 

1. Click on “View” tab at top of screen. 
2. In the “Workbook Views” section, select “Page Layout”. 

3. In the “Show” section, uncheck the boxes next to “Ruler”, “Gridlines”, “Formula 
Bar”, and “Headings”. 

4. In the “Zoom” section, select “100%”. 

 
FORMS PRINT ON MULTIPLE PAGES 
 

Problem:  The forms print out on multiple pages. 
 

Fix:  Adjust the margin settings. 
 

Instructions: 
1. Under the “Page Layout” tab, select “Margins” from the menu.  (See LG100A 

section for screen display.) 
2. Then select “Custom Margins”. 

3. Reset the margins to these sizes, if necessary, and click OK. 
– top, bottom, left, and right margins should be set at .25”. 
– header and footer should be set at .3”. 

The page should now view correctly. 
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“GCB USE” PAGE PRINTS 
 

Problem:  The “GCB Use” worksheet prints on several pages when I print out the 
forms. 
 

Fix:  Don’t print the “GCB Use” page.  This worksheet is not meant to be printed. 
 

Instructions: 

Refer to the “Printing the Forms” section of these instructions. 
 
DIDN’T RECEIVE CONFIRMATION EMAIL 
 

Problem:  I emailed my GCBREPORTS file, but didn’t receive a confirmation email. 
 

There are several reasons this may happen.  Below are three causes that have 

come to our attention along with instructions on how to fix each problem. 
 

1) Email address was entered incorrectly. 
 

Fix:  Go to your email program’s “Sent Items” folder.  Double-check the 

accuracy of the email address entered.  The address should be 
gcbreports@gcb.state.mn.us.  If an error was made, send another email to 

the correct address. 
 

2) Your email program put the confirmation into your Spam/Junk folder. 
 

Fix:  Open your email program’s “Spam” or “Junk Email” folder.  Then look 

through the list of emails received to determine whether you received an 
email from “Minnesota GCB”. 
 

If the confirmation email did go into your Spam/Junk folder, add the 

following email address to your email “address book” or “contacts”:  
minngcb+canned.response@gmail.com 
 

Future confirmations should then automatically go to your regular “Inbox”. 
 

3) Your email program simply won’t accept a confirmation email from the 
address minngcb+canned.response@gmail.com. 

 

Fix:  This problem occurs more often for those using a company or 

governmental entity’s email account.  Those accounts may be set up to not 
accept any automated responses as a safeguard against someone purposely 
trying to overwhelm and shut down their entire email system.  If so, it is 

recommended that you establish a new email account with a popular email 
provider such as Google or Yahoo.  Then resend your GCBREPORTS file to 

gcbreports@gcb.state.mn.us.  If you still don’t get a confirmation, check 
items #1 and #2 above. 
 

“OPENOFFICE” COMPATIBILITY – LG100C 
 

Problem:  Dates entered change to numbers. 
 

Fix:  If using the OpenOffice spreadsheet program, the month, date, and year must 
be separated by a forward-slash (“/”).  For example, July 4, 2014, should be 
entered as 07/04/2014.  If you enter the date as “7-4-14”, the OpenOffice 

spreadsheet will treat the data as a mathematics problem of seven minus four 
minus fourteen. 

 

mailto:minngcb+canned.response@gmail.com
mailto:minngcb+canned.response@gmail.com
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